CONTENTS

- Field of Application
- Installation on Windows
- Installation on Mac
- Activation
- License Comparison
- Workspace
- Using the Program
- Pastel Effect
- Abstract Art
- Canvas
- Frames
- Text
- Toolbar
- Timeline
- Presets
- Preferences
- Batch Processing
- Print Image
- Swans: Dance on the Water
- AKVIS Programs
AKVIS Pastel is the best software for conversion of photos into pastel paintings. The program turns your image into a lifelike digital art imitating one of the most popular artistic techniques - pastel art.

Pastel bridges the gap between painting and drawing. The pastel sticks consisting of powdered pigment generate soft velvety strokes with subtle edges which can be smeared with your fingers. To paint in pastels, you need a rough textured surface which holds the pigment.

A distinctive feature of the pastel technique is the deep vibrant shimmering colors and rich velvety texture. Unlike oil and watercolor paints, pastels don't cover the whole surface. The small gaps let the paper show through the strokes and increase the general picturesque effect.
AKVIS Pastel is a powerful tool to unleash your creativity. Once you load your image in the program, you can choose one of the effect presets or change the pastel settings to create a unique painting. The adjustable effect parameters give you a strong sense of control over your digital art. The software starts creating your new pastel by a mouse click.

The advanced brush tools will help you to refine the result, change the direction of the automatic strokes, strengthen or weaken the pastel effect on different areas, put the finishing touches to your picture.
To obtain a true pastel painting, it’s especially important to choose a right surface. Generally, pastel artists use a textured paper. With the software you can put your painting to any surface: sanded paper, MDF board, brick wall, and others.
Abstract artworks are hard to look away from; they express the balance between order and chaos, geometry and nature. The Abstract Art tab expands the range of creative opportunities by enabling you to create non-objective pastels in vibrant, vivid colors. Experiment with shape, form, color and line to make your digital paintings come alive!
Using the program, you can not only create a pastel painting from your photo, you can personalize your artwork by adding a signature, a title, or a greeting.

In addition, a rich library of amazing frames to decorate pastel drawings is accessible directly in the program.

The Batch Processing option in the program lets you apply the artistic effect to a folder full of images and automatically convert all pictures. It is a very useful and time-saving feature especially when you need to make a number of drawings at the same style for a site, blog or booklet.

**AKVIS Pastel** is available as a standalone program and as a plugin to a photo editor, for Windows and Mac.

The plug-in is compatible with Adobe Photoshop, Photoshop Elements, Corel Paint Shop Pro, etc. [Consult the compatibility page](#) for more details.

The functionality of the program depends on the license type. During the trial period you can try all options and choose the license you like.
Follow the instructions to install **AKVIS Pastel** in Windows.

- Start the setup **exe** file.
- Select your language and press the **OK** button to launch the installation process.
- To continue the installation process you have to read and accept the **License Agreement**.
  
  Activate the check box "**I accept the terms in the license agreement**", and press **Next**.

- To install the **Plugin** you should select your photo editor(s) from the list.
  
  **Hint:**
  If your photo editor is not in the list, activate the component **Custom Plugins Directory** and choose the folder where you keep all plugins and filters, for example, **C:\My Plugins**. In this case you should set this folder as the plugins folder in the settings of your photo editor.

  Or you can copy the **8bf** file into the Plug-ins folder of your image editor.

To install the **Standalone version**, make sure that the check-box **Standalone** is activated.

To create a shortcut for the program on desktop, activate the component **Shortcut on Desktop**.

Press the button **Next**.
• Press the button **Install**.

• The installation is in progress.
The installation is completed.

You can subscribe to the AKVIS Newsletter to be informed about updates and events.

Press Finish to exit Setup.

After installation of the standalone version of Pastel, you will see a new line in the Start menu: AKVIS - Pastel and a shortcut on desktop, if during installation the component Shortcut on Desktop was enabled.
After installation of the Pastel plugin you will see a new item in the Filter/Effects menu of your photo editor. For example in Photoshop: **Filter -> AKVIS -> Pastel.** Please use this command to launch the plugin in the editor.
Installación

Seguir las instrucciones para instalar **AKVIS Pastel** en un Mac:

- **Abrir el disco virtual dmg:**
  - **akvis-pastel-app.dmg** para instalar la **versión Standalone**
  - **akvis-pastel-plugin.dmg** para instalar la **Plugin** a su editor de imágenes (Photoshop o Photoshop Elements).

- **Lea la Licencia de Acuerdo** y presione **Aceptar**, si está de acuerdo con las condiciones.

**Finder** abrirá la aplicación **AKVIS Pastel** y la **PlugIn** dentro.

**Para instalar la versión Standalone** solo arrastre la aplicación **AKVIS Pastel** a la carpeta **Aplicaciones** (o cualquier otro lugar a su preferencia).

**Para instalar la Plugin** arrastre toda la carpeta **AKVIS Pastel PlugIn** a la carpeta **Plug-Ins** de su editor gráfico.

Por ejemplo:

- **si usa Photoshop CC 2018**, copie el plugin a **Aplicaciones/Adobe Photoshop CC 2018/Plug-Ins**;
- **si usa Photoshop CC 2017**, copíelo a **Aplicaciones/Adobe Photoshop CC 2017/Plug-Ins**;
- **si usa Photoshop CC 2015.5**, copie el plugin a **Library/Application Support/Adobe/Plug-Ins/CC**;
- **si usa Photoshop CC 2015**, copíelo a **Aplicaciones/Adobe Photoshop CC 2015/Plug-ins**;
- **si usa Photoshop CS6**, copíelo a **Aplicaciones/Adobe Photoshop CS6/Plug-ins**.
After installation of the plugin, you will see a new item in the Filter menu of your photo editor. In Photoshop select in menu: **Filter -> AKVIS -> Pastel.**

Run the standalone app by double-clicking on its icon in Finder.
HOW TO ACTIVATE AKVIS SOFTWARE

Attention! During the activation process your computer must be connected to Internet.
If it is not possible, we offer you an alternative way (see below for Offline Activation).

Download AKVIS Pastel and install the program. Read the Installation Instruction here.
When you run the unregistered version, a splash window will appear displaying general information about the version and the number of days left in your trial period.
You can also open the About the Program window by pressing the button in the program's Control Panel.

Click on TRY IT to evaluate the software. A new window will appear with variants of licenses to test.
You do not need to register the trial version to try all features of the software. Just use the program during the evaluation time (10 days after the 1st start).
During the test period you can try all options and choose the license you like. Select one of the offered functionality types: Home (Plugin or Standalone), Home Deluxe, or Business. Your choice of license will affect which features will be available in the program. Consult the comparison table for more details about license types and versions of the software.
If the trial period has expired, the TRY IT button is disabled.

Click on BUY NOW to choose a license to order.
When the payment is effected, your serial number for the program will be sent to you within minutes.

Click on ACTIVATE to start the activation process.
Enter your name (the program will be registered to this name).

Enter your serial number (your license key).

Choose the method of activation — either direct connection to the activation server or by e-mail.

**Direct connection:**

We recommend activating the program using direct connection, as it is the easiest way.

At this step your computer must be connected to Internet.

Press **ACTIVATE**.

Your registration is completed!

**Request by e-mail:**

In case you have chosen activation by e-mail, a message with all necessary information will be created by the program.

**NOTE:** You can also use this method for **Offline Activation**:

If your computer is not connected to Internet, transfer the activation message to a computer connected to Internet, for example, with a USB stick. Send us this information to: activate@akvis.com.

**Please do not send the screenshot!** Just copy the text and save it.

We need your serial number for the software, your name, and HardwareID (HWID) of your computer.

We will generate your license file (Pastel.lic) using this information and will send it to your e-mail address.

Save the .lic file (do not open it!) to your computer where you want to register the software, in the **AKVIS** folder in Users’ Shared (Public) Documents:

- **Windows Vista/7/8/10:**
  
  \`Users\Public\Documents\AKVIS;\`

- **Windows XP:**
  
  \`Documents and Settings\All Users\Documents\AKVIS;\`

- **Mac:**
  
  \`Users/Shared/`AKVIS.\`
Your registration is completed!

When the program is registered, **BUY NOW** turns to **UPGRADE** that lets you improve your license (for example, change **Home** to **Home Deluxe** or **Business**).
**AKVIS Pastel** lets you apply the lifelike pastel effect to your images. The product is available as a standalone application and as Photoshop compatible plugin.

The functionality of the software depends on the license type. During the test period you can try all options and choose the license you like. Every time you start the unregistered version you can choose between functionality types to test: **Home** (either the plugin or the standalone edition), **Home Deluxe** (plugin+standalone) or **Business** (plugin+standalone).

<table>
<thead>
<tr>
<th>License Comparison:</th>
<th><strong>Home</strong> (Plugin)</th>
<th><strong>Home</strong> (Standalone)</th>
<th><strong>Home Deluxe</strong> (Plugin+Standalone)</th>
<th><strong>Business</strong> (Plugin+Standalone)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Purpose</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>non-commercial use</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>commercial use</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Edition</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Plugin</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Standalone</td>
<td>—</td>
<td>✓</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Features</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pastel Painting Effect</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Abstract Art</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Crop</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Stroke Direction Tool</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Post-Processing Tools</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Additional Features:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timeline</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Canvas</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Text</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Frames</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Presets</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Import/Export Files:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>*.pastel (Presets)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>*.direction (Guiding lines)</td>
<td>—</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Batch Processing</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Share</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Print</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Large Format Print</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>EXIF, IPTC</td>
<td>—</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Color Space</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>RGB</td>
<td>CMYK</td>
<td>Lab</td>
<td>Grayscale</td>
</tr>
<tr>
<td>------------------</td>
<td>-----</td>
<td>------</td>
<td>-----</td>
<td>-----------</td>
</tr>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Image Format**

<table>
<thead>
<tr>
<th>Format</th>
<th>RGB</th>
<th>CMYK</th>
<th>Lab</th>
<th>Grayscale</th>
<th>8 / 16 bits</th>
<th>32 bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIFF</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>JPEG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>BMP</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PNG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>RAW</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DNG</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PSD</td>
<td>✓</td>
<td>—</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**OS**

<table>
<thead>
<tr>
<th>OS</th>
<th>RGB</th>
<th>CMYK</th>
<th>Lab</th>
<th>Grayscale</th>
<th>8 / 16 bits</th>
<th>32 bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Mac</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**10-days trial**

<table>
<thead>
<tr>
<th></th>
<th>RGB</th>
<th>CMYK</th>
<th>Lab</th>
<th>Grayscale</th>
<th>8 / 16 bits</th>
<th>32 bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Price**

<table>
<thead>
<tr>
<th>OS</th>
<th>RGB</th>
<th>CMYK</th>
<th>Lab</th>
<th>Grayscale</th>
<th>8 / 16 bits</th>
<th>32 bits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>$ 49</td>
<td>$ 49</td>
<td>$ 69</td>
<td>$ 89</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
AKVIS Pastel lets you transform a photograph into a pastel artwork. The software can be used independently as a *standalone* program or in a photo editor as a *plugin* filter.

- **Standalone** is an independent program; you can open it by clicking on the program's icon.
  
  To launch the standalone version, run the program directly:
  
  On a Windows computer - select it from the *Start* menu or use the program's shortcut.
  
  On a Mac computer - launch the app from the *Application* folder.
  
- **Plugin** is an add-on for a *photo editor*, for example for Photoshop.
  
  To call the plugin, select it from filters of your image editing program.

The program's workspace looks like this:

![Workspace of AKVIS Pastel](image)

The left part of the **AKVIS Pastel** workspace is taken by the Image Window with two tabs: **Before** and **After**. Under the **Before** tab you can see the original photo. The **After** tab shows the resulting image. You can switch between the windows by left-clicking on the tab with mouse button. To compare the original and the resulting images, click on the image and hold the button pressed - the program will currently switch between tabs.

In the upper part of the program's window you can see the **Control Panel** with these buttons:

The button ![home page](image) opens the home page of **AKVIS Pastel**.

The button ![loading operations](image) is used for managing the loading operations.

Right mouse click on this button displays the list of recent images. You can change their number in the program's preferences.

Left mouse click shows the list of the commands:

- ![image](image) (available only in the standalone version) - It opens an image. The hot-keys are **Ctrl+O** on Windows, **⌘+O** on Mac.
- It loads saved guiding lines (.direction file).
- It loads a list of presets (.pastel file).

The button shows the list of the saving commands:

(available only in the standalone version) - It saves the image in the chosen format. The hot-keys are Ctrl+S on Windows, ⌘+S on Mac.
- It saves the guiding lines to a .direction file.
- It saves user presets to a file with the .pastel extension.

The button (only in the standalone version) calls the Print dialog box. The hot-keys are Ctrl+P on Windows, ⌘+P on Mac.
The button lets posting pictures from the program to the social networks: Twitter, Flickr, Tumblr, Google+.
The button / shows/hides the guiding lines.
The button cancels the last operation (with the tools). It is possible to cancel several operations in a row. The hotkeys are Ctrl+Z on Windows, ⌘+Z on Mac.
The button returns the last cancelled operation. It is possible to return several operations in a row. The hotkeys are Ctrl+Y on Windows, ⌘+Y on Mac.
The button (only in the standalone version) opens the Batch Processing dialog to automatically process a series of images.
The button initiates image processing with the current settings. The resulting image is shown in the After tab.
The button (only in the plugin version) applies the result to the image and closes the plugin.
The button shows information about the program: version, trial period, license.
The button calls the Help files. The hot-key is F1.
The button calls the Preferences dialog box for changing the program's options.

To the left of the Image Window there is the Toolbar. Different tools appear on the Before/After tabs.

**Pre-Processing Tools** (in the Before tab):

The button switches on/off the quick preview window.
The button (only in the standalone version) activates the Crop tool which allows cutting off unwanted areas in the image.
The button activates the Stroke Direction tool to draw the guiding lines (for Home Deluxe and Business licenses).
The button activates the Eraser tool used to remove the guiding lines, either partially or fully.

**Post-Processing Tools** (in the After tab, for Home Deluxe and Business licenses):

The button activates the Smudge tool which is used to manually refine images by removing paint irregularities.
The button activates the History Brush tool which lets you fade the effect and restore the image, partially or fully, to its original state.
The button activates the Pastel Chalk tool which lets you draw soft textured strokes. The tool imitates a pastel stick and helps to strengthen the hand-made effect.
Additional Tools:

The button \( \text{Hand} \) activates the **Hand** tool which allows you to scroll the image when it does not fit within window at the desired scale. To use it click on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction. Double-clicking on the tool's icon \( \text{Hand} \) makes the image fit the window.

The button \( \text{Zoom} \) activates the **Zoom** tool, which changes the image's scale. To zoom in left click on the image. To zoom out left click with \( \text{Alt} \) on the image. Press \( \text{Z} \) to quickly access the tool. Double-clicking on the tool's icon \( \text{Zoom} \) makes the image scale to 100% (actual size).

Navigate and scale the image using the **Navigator**. The frame in the **Navigator** surrounds the area of the image which is visible in the main window; the area outside of the frame will be shaded. The frame can be dragged, thereby changing the visible portion of the image. To move the frame, place the cursor within it, left click the mouse, and then drag.

To scroll the image in the window you can press the spacebar on the keyboard and drag the image with the left mouse button. Use the scroll wheel of the mouse to move the image up/down, by keeping the \( \text{Ctrl} \) key pressed – to the left/to the right, by keeping the \( \text{Alt} \) key pressed – scale the image. Right-click on the scroll bar to activate the quick navigation menu.

Use the slider or the buttons \( + \) and \( - \) to scale the image in the main window. When you click on the \( + \) button or move the slider to the right, the image scale increases. When you click on the \( - \) button or move the slider to the left, the image scale reduces.

You can also change the image scale by entering a new coefficient into the scale field. The fall-down menu shows some frequently used coefficients.

You can use hot-keys to change the image scale \( + \) and \( \text{Ctrl} + + \) \( (\text{⌘} + + \text{Mac}) \) to increase the image scale and \( - \) and \( \text{Ctrl} + - \) \( (\text{⌘} + - \text{Mac}) \) to reduce the scale.

Under the **Navigator** there is the Settings Panel with the tabs:

- **Painting**: Here you can adjust the settings for pastel effect.
- **Abstract Art**: Create colorful artworks with whimsical and fantastic shapes.
- **Decoration**: Add text to an image, adjust the canvas surface, and apply a frame.

Below, in the **Presets** field you can save the current settings as a preset to use them in the future. The current settings can be saved, edited, deleted. When you launch the program, it uses the settings of the last used preset.

Under the settings and presets you can see **Hints** for the parameters and buttons when you hover over them with the cursor. You can choose where the hints will be shown or hide them in the program's **Preferences**.
AKVIS Pastel lets you transform a photograph into a pastel artwork. The software can be used independently as a standalone program or as a plugin filter in a photo editor.

To create a pastel painting from your photo, follow these instructions:

**Step 1.** Open an image.

- If you work with the standalone edition:

  The dialog box **Select File to Open** appears if you double-click on the empty workspace of the program or if you click on then on . Use the hot-keys: Ctrl+O on Windows, ⌘+O on Mac.

  You can also drag the required image into the workspace of the program.

  The standalone program supports JPEG, RAW, PNG, BMP, and TIFF file formats.

- If you work with the plugin:

  Open an image in your photo editor by calling the command **File -> Open**.

  Call the plugin from the menu of the editor:

  - in Adobe Photoshop and Photoshop Elements - Filter -> AKVIS -> Pastel;
  - in Corel PaintShop Pro - Effects -> Plugins -> AKVIS -> Pastel;
  - in Corel Photo-Paint - Effects -> AKVIS -> Pastel.
**Step 2.** In the standalone version, before applying the pastel effect, you can cut off unwanted areas of the picture and improve its composition with the **Crop tool**.

If you use the plugin, you can do this in your image editor.

![Crop Tool](image.png)

**Step 3.** Adjust the pastel effect settings in the **Painting** tab.

Using the **Abstract Art** tab you can change the shape and color of objects, giving them a unique and fantastic look.

You can choose one of the **Preset**s or set the parameters to your liking.

The result will be immediately shown in the **quick preview window** which is visible in the **Before** tab if the button [ ] in the Toolbar is pressed.

![Preview Window](image.png)

**Step 4.** Press the button [ ] to convert the entire image into a pastel painting with the selected settings.

To interrupt the process, click on the **Stop** button right to the progress bar.
Step 5. For the advanced licenses (Home Deluxe/Business), it is possible to improve the result of the automatic conversion using the Stroke Direction tool that helps to change the direction of the strokes.

Draw guiding lines and click on to re-process the image.

Step 6. To make your work of art even more realistic and truly impressive, you can use the Decoration options: Canvas, Frame, and Text.

Hint: The order of the application of the decoration effects depends on the position of the tabs. Drag the tabs to change the order.

Step 7. If you like your new settings, you can save them as a preset and use them later. Type a name for the preset into the Presets field and press Save. When a new preset is created, it will be available in all three tabs and will contain their settings.

Step 8. Using the Timeline feature you can get variations of your pastel drawing without adjusting the effect settings. If you like some semi-processed image more than your final result, click on it to choose. The selected shot will be shown in the After tab, as a result.

If you want to get back to your final result, click on the last shot in the Timeline list.

Note: This feature is only available for the Home Deluxe and Business licenses.
You can set the number of the shots in the **Preferences** dialog box.

**Step 9.** You can put the finishing touches to your pastel painting with the **Post-Processing Tools** available under the **Home Deluxe/Business** licenses, in the **After** tab.

**Attention!** Use these tools at the final step. If you run the processing again, the changes made with the tools will be lost!

**Step 10.** Share your work of art by clicking on . It opens the list of the services where you can publish the image: Twitter, Flickr, Tumblr, Google+.

In the standalone version, you can also **print** your pastel painting with .

**Step 11.** Save the processed image.

- **If you work with the standalone edition:**
  
  Click on then on to open the **Save As** dialog box. You can use the hot-keys: \texttt{Ctrl}+\texttt{S} on Windows, \texttt{⌘}+\texttt{S} on Mac. Enter a name for the file, choose the format (TIFF, BMP, JPEG or PNG) and indicate the target folder.

- **If you work with the plugin:**
  
  Press the button to apply the result and close the plugin window. The **AKVIS Pastel** plugin will close and the picture will appear in the workspace of the photo editor.

  Call the **Save As** dialog box using the command **File -> Save As**, enter a name for the file, choose the format and indicate the target folder.
AKVIS Pastel turns your photograph into a work of art imitating one of the most popular artistic techniques - pastel.

Pastel bridges the gap between painting and drawing. The pastel sticks consisting of powdered pigment generate soft velvety strokes with subtle edges which can be smeared with your fingers. To paint in pastels, you need a rough textured surface which holds the pigment. A distinctive feature of the pastel technique is the vibrant shimmering colors.

Look at the pastel painting created in AKVIS Pastel:
To create a pastel from a photo adjust the effect settings in the **Painting** tab:

**Paper Color.** You can change the color of the pastel paper by clicking on the color plate.

![White Paper](image1)
![Blue Paper](image2)

**Stroke Thickness** (0-100). The parameter affects the width of the strokes and gaps. Thick strokes are applied more tightly than thin.

![Stroke Thickness = 5](image3)
![Stroke Thickness = 70](image4)

**Min/Max Stroke Length** (1-100). The parameter covers the full range of possible stroke lengths. Stroke Length is controlled by the position of two sliders on the same scale: the left slider sets the *minimum* stroke length while the right slider controls the *maximum* stroke length. You will see only the strokes greater than the minimum and shorter than the maximum settings.

![Min/Max Stroke Length = 5/15](image5)
![Min/Max Stroke Length = 90/100](image6)
**Stroke Intensity** (0-100). The parameter makes the strokes more distinct and perceptible. Lower values will result in paler, weaker, and softer strokes. At higher values more pigments are concentrated into each stroke, so the lines become darker, larger, and more noticeable.

**Stroke Density** (0-200). The parameter affects the number of the strokes. The higher the value, the fewer areas will remain unpainted.

**Attention:** High values of this parameter will significantly increase processing time.

**Lightening** (0-100). The parameter emphasizes and increases light areas in the image. The higher the value, the stronger the effect is, and the more light tones are used.

**Smoothing** (1-10). The parameter lets tightening and smearing the strokes.
**Small Details.** The check-box allows you to emphasize fine details and patterns in the image.

**Large Strokes.** The check-box increases the size of the strokes in uniform areas.
Large Strokes check-box is enabled

Both check-boxes are enabled
Using the Abstract Art tab you can change the shape and color of objects, giving them a unique and fantastic look.

**Note:** This tab is available only for Home Deluxe and Business licenses.

The parameters are divided into three groups:

**Strokes** Group. The parameters change the color of strokes in the resulting image.

- **Color** (0-180). The higher the value, the more strokes are recolored and the more colors appear in the image.

- **Saturation** (0-100). The parameter increases the brightness of random strokes. The default value is 0.
Contrast (0-100). The parameter makes random strokes darker/lighter.

Correction Group. The parameters change the color of the original image.

Hue (-180…180). The parameter shifts all colors by the same hue value.

Saturation (-100…100). The parameter lets toning the image with brighter colors. It allows you to change the intensity of colors: from neutral gray tones to bright colors.
Brightness (-100...100). The luminance of the image. At higher values the image is brighter while at lower values it is darker.

Distortion Group. The parameters change the shapes and proportions of the objects.

Strength (0-100). The amount the objects in the image are shifted and stretched. At a value of 0, there is no distortion.

Curvature (2-25). This parameter increases the waviness of contours.
Random Seed (1-9999). This is the starting number for the random number generator that defines the deformation of shapes and randomly combines strokes.
To obtain a true pastel effect, it's especially important to choose a right surface. Generally, pastel artists use a textured paper. With the AKVIS Pastel program you can put your painting to any surface: sanded paper, MDF board, brick wall, and others.

In the Decoration group switch to the Canvas tab to choose and adjust a texture for your artwork. Enable the Use Canvas check-box.

Hint: You can drag the Canvas/Frame/Text tabs to change the order of the application of the decoration effects.

You can choose a texture from Library -> Surface or load your own sample: Library -> Custom...

Adjust the canvas settings.
In **AKVIS Pastel** you can also add a frame to your pastel painting to create a real work of art.

In the **Decoration** group switch to the **Frame** tab, enable the check-box of the same title, and choose the frame style and texture.

**Hint:** You can drag the **Canvas/Frame/Text** tabs to change the order of the application of the decoration effects.

You can apply these frames to your pastel art:

- **Classic Frame**
- **Pattern Frame**
- **Strokes**
- **Vignette**
- **Passe-Partout**
ADD TEXT/WATERMARK TO A PASTEL ART

In **AKVIS Pastel** you can sign or watermark your newly created work of art.

Select **Decoration -> Text** to apply an inscription to your pastel drawing. By default, the parameters of the tab are disabled. Enable one of the modes: **Text** or **Image**.

**Hint:** You can drag the **Canvas/Frame/Text** tabs to change the order of the application of the decoration effects.

You can add any text or image.

**Adjust the text/watermark settings.**
In **AKVIS Pastel** Toolbar different tools become visible depending on the active tab, **Before** or **After**.

The tools in the program are divided into the groups: **pre-processing** (**Before** tab), **post-processing** (**After** tab), and **additional** tools (**Before** and **After** tabs).

**Hint:**
You can use the buttons and to undo/redo the operations made with the tools: .

**Pre-Processing Tools** (on the **Before** tab):

**Quick Preview** switches on/off the preview window. It is a square frame outlined with the "marching ants" that displays changes made in the **Painting** and **Decoration** tabs.

You can drag the preview square to any position with the left mouse button or with the double click. This lets you quickly preview the effect in different areas of the image. To compare the result of automatic conversion with the original picture, click and keep mouse pressed within the preview area.

You can adjust the preview window size in the program's preferences.
**Crop** (in the standalone version) lets you cut off unwanted areas in the image. The tool is useful when you want to improve the image composition, straighten a crooked photo, turn a horizontal photo into a vertical one and contrariwise.

**Note:** This tool is applied to the original image! Use it before the pastel effect.

You can change the crop area by dragging the sides and the angles of the bounding frame.

To apply the result and remove the areas outside the frame, press **OK** or use **Enter**. To cancel the operation and exit the tool, press **Cancel** or use the **Esc**-key. To restore the original area keeping the tool active, press **Reset** button.

Adjust the crop options:

- You can choose the size of the crop rectangle from the **Ratio** drop-down list or enter your custom aspect ratio.
- If the **External Area** check-box is enabled, you can change the color and opacity of the outer parts.

**Stroke Direction** gives you full control over the strokes. With this technique you can achieve truly realistic paintings with human hair, patterns, and textures going in the right direction.

**Note:** This feature is only available for the advanced licenses (**Home Deluxe, Business**).

Add the **guiding lines** with this tool, and the program will re-make the painting following the new direction. The changes will be shown in the preview window. To re-start the image processing, click on the button.
Hint: You can save and load the guiding lines created with this tool. Loaded lines automatically adapt to the image size.

Eraser lets you edit and remove the guiding lines drawn with the Stroke Direction tool. The size of the eraser can be adjusted by right clicking on the image.

Post-Processing Tools (on the After tab, for Deluxe/Business):

Attention! The tools are only available under the Home Deluxe/Business licenses, on the After tab. Use them at the final step. If you re-run the image processing, the changes made with the post-processing tools will be lost!

The tools' options are shown in a pop-up box which appears after right-clicking in the image.

Smudge is designed for mixing colors in the picture and removing irregularities.

The tool's parameters:

- **Size** (1-300). The maximum width of a line drawn with the tool.
- **Hardness** (0-100). The amount of blurriness of the outer edge. The higher the value, the harder the brush edge is.
- **Strength** (1-100). The intensity of smearing the paint in the stroke. The higher the value, the more color is smeared.
History Brush lets you fade the pastel effect and restore the image to its original state. You can choose the mode of the tool: edit all changes or only brushes keeping the effect.

The tool's parameters:

- **Restore to Original.** If the check-box is enabled, the tool lets weakening the pastel effect, as well as the result of the post-processing brushes. If the check-box is disabled, the tool edits only these brushes but does not affect the pastel effect.

- **Size** (1-1000). The maximum width of a line made by the brush.

- **Hardness** (0-100). The blurriness of the tool's edges. The less the value the more blurry the tool's edges become. At value 100% the border between the brush's edges and the background is very distinct; at lower values the transition between these areas is smoother.

- **Strength** (1-100). The degree of restoration to the original state. At lower values there will be less restoration and more blending with the effect; at value 100% the original image will be restored more completely.
**Pastel Effect Using History Brush**

**Pastel Chalk** lets you draw soft textured strokes. The tool imitates a pastel stick and helps to strengthen the hand-made effect.

- **Size** (1-200). The maximum line width which can be drawn with the tool.
- **Strength** (0-100). The impact of the tool. At higher values, the line drawn by the chalk will be more thick and dense.
Color. Click on the button to activate the Eyedropper tool that allows you to pick a color from the image. You can also use the I-key.

Around the eyedropper’s tip over the image you will see a color ring with the adjacent tints:

1. Gradient line with the current color in the center. On the left side is +30% black, and on the right side +30% white.
2. The previously selected color.
3. The current color of the pixel where the cursor is.
5. Average colors from areas of 3x3, 5x5, 11x11, 31x31, 51x51, 101x101 px.

The color ring helps you to select colors more precisely. If it’s hard to catch a certain color, you can select a tint on the ring with the Ctrl-key.

Double click on the square button lets you choose a color from the Select Color dialog.

Additional Tools (available on both tabs, for all licenses):

Hand lets you scroll the image when it does not fit within Image Window at the desired scale. To use it click on the button, bring the cursor over the image, and while keeping the left mouse button pressed move in the desired direction. The hot-key is H.

Double-clicking on the tool's icon on the Toolbar makes the image fit the window.

Zoom lets you change the image's scale. To zoom in left click on the image. To zoom out left click with Alt on the image. The hot-key is Z.

Double-clicking on the tool's icon makes the image scale to 100% (actual size).
**AKVIS Pastel** lets you observe the conversion of your photo into a pastel drawing in real time. During the process, the program creates a list of intermediate shots which represent different stages of conversion — from a semi-processed image to a practically finished work. This wonderful option allows you to create variations of drawings without changing the settings.

The **Timeline** is displayed at the bottom of the main window.

![AKVIS Pastel](image)

**Attention:** The **Timeline** feature can only be used by owners of **Home Deluxe** and **Business** licenses. Note that everyone, even with a **Home** license, can get a semi-processed image using the **Stop** button in the progress bar.

Start conversion of your photo into a drawing by pressing the button 🎬. You will see shots appearing at the bottom of the window in the course of processing.

You can also take snapshots of your favorite moments with the button 📸 right of the progress bar. When you press it the drawing in its current state will be added to the list; such manual shots are selected with the blue frame.
If you press the **Stop** button in the progress bar, image processing will be interrupted.

Browse the shots in the **Timeline** to find the image you like most. If you want to get back to your final result, click on the last shot in the list.

When you change the parameters and re-run image processing, the **Timeline** will be cleaned up and will start being filled up with new shots. You can save some of the variants by pinning them with a double click. In the upper corner of the selected shot appears the icon ![pin icon](image).

You can switch between the shots, change the settings and re-start processing - the pinned result will remain in the list. It's possible to unpin it with a double click.

**Attention!** Loading a new image into the program removes all shots, including pinned.

**Note:**
After using the post-processing tools ![post-processing tools](image), switching to another image in Timeline will result in the loss of changes made with the tools. You can save the result under a new name and continue working.
You can hide/show the **Timeline** in the program's preferences. If the **Timeline Shots** option is enabled, you can set the number of the shots created during image processing.

![Program's Preferences](image)

Program's Preferences
AKVIS Pastel includes a number of ready to use Presets which help you start working. They can be applied "as is" or can be modified.

When moving a cursor over an AKVIS preset in the drop-down list, the sample appears in the small window near the list.

All tabs of settings have the common list of presets. When a new preset is created it will be available in all tabs and will contain their settings.

To create a preset, adjust the settings, type a name for the preset into the field, and press Save.

To return to the default settings of the selected preset, press Reset.

To delete a preset, choose it from the drop-down list and press Delete.

The AKVIS built-in presets cannot be removed.

You can save your presets to a .pastel file with Save. To load presets from the file use Load.

Read more how to import and export user presets.
The button 
  opens the Preferences dialog box that looks like this:

- **Language.** Change the program language by selecting another from the drop-down list.
- **Interface Scale.** Choose the size of the interface elements. When it is set to Auto, the program workspace will automatically scale to fit the screen resolution.
- **Interface Theme.** Select the style of the program interface: Light, Gray, or Dark.
- **Preview Window Size.** Choose the desired value for the size of the quick preview window: from 200x200 px to 1000x1000 px.
- **Processing Size Limit.** Image processing is a very time-consuming operation. This parameter accelerates image processing by temporarily reducing the size of the image to be processed. When the file size (in megapixels) does not exceed the defined value, the image is processed in the usual way. If the loaded file is larger, the program will reduce the image, process it and enlarge it again to the initial size.
- **Initial Image Scale.** This parameter defines the way the image is scaled in the main window after loading:
  - **Fit to View.** The scale adjusts so that the image will be completely visible;
  - **100%.** The actual size is used, the image doesn't scale.
- **Timeline Shots.** This parameter changes the number of the shots created during image processing (available only for Home Deluxe and Business licenses).
- **Hints Panel.** You can choose how the hints will be shown:
  - Under Image Window;
  - Under Settings Panel;
  - Hide.
- **Recent Files** (available only in the standalone version). The number of recent documents. The list of the recent files, sorted by time, become visible by right mouse clicking on . Maximum: 30 files.
- **Use OS File Dialog** check-box. Enable this option if you want to use the System Open/Save Dialog. Otherwise, the AKVIS File Dialog is used.
- **Lock the Control Panel** check-box. It disables the possibility to hide/show the top panel. If the check-box is selected the panel is always visible.
To apply changes made in the Preferences window press OK.

If you need, click on the button Default to return to the default settings.
**BATCH PROCESSING**

**AKVIS Pastel** supports the **Batch Processing** feature that lets you automatically convert a series of images with the same settings and saves you time and efforts. It is useful when creating a number of illustrations at the same style for a booklet or when processing all frames of video.

Even if you've never used this feature before it is simple to learn!

If you use the standalone version of **AKVIS Pastel**, read the instructions here.

If you use the **Pastel** plugin in Photoshop, use this tutorial.
The AKVIS plugins support the automation feature in Adobe Photoshop.

Batch processing is very useful and time saving when you have to apply the effects to a number of photos. This method applies the same settings to a folder full of images.

Even if you have never used batch processing you will find no difficulties in understanding it. First you create an Action in Photoshop and then apply it to a photo folder.

Follow the instructions:

**Step 1.** Create two new folders, for example: "source-files" and "result-files". Place original images into the "source-files" folder. The results will be saved in the "result-files" folder.

**Step 2.** Open one of the original images in Adobe Photoshop. We will use this photo to adjust the plugin's settings and create an action.

**Step 3.** In the Actions palette click Create New Set button. In the dialog window give a name for a new set of actions, for example, "AKVIS Actions".

If you already have a special set for the AKVIS actions, you can just choose it.

**Step 4.** Press Create New Action and give a name for it, for example, "Neon".
Press the **Record** button, and the recording of the action will immediately start.

**Step 5.** Call the plugin and adjust its parameters.
Step 6. Press the button 🔄. The plug-in window will close and the effect will be applied to the image. In the Actions palette, in your new action, you will see a new line with the plugin's name.

Step 7. Remember that the action is still being recorded. Now, you should save the image. Choose Save As in the File menu and save the image into the destination folder.

Step 8. Stop the action recording by pressing Stop playing/recording at the bottom of the Actions palette.

Step 9. Delete the file that you have just saved.

Step 10. The action is created and you can proceed to batch processing of the photos.

In the File menu of the editor choose Automate -> Batch.

Step 11. In the Batch dialog window and set the parameters:
- In the Set drop-down list choose "AKVIS Actions" and the new action.
- In the Source option set Folder. Press the Choose... button and select "source-files".
As the Open command was not recorded in the action, the **Override Action "Open" Commands** check-box should be deactivated.

For **Destination** select **Folder**, then press the **Choose...** button and select "result-files".

Activate **Override Action "Save as" Commands** check-box.

In the **File Naming** section you can create the filenames structure for the resulted images. If you do not want to change the names, in the first combo-box choose **document name**, and in the second - **extension**.

**Step 12.** Press **OK** to start processing. Photoshop will apply the AKVIS plugin to all photos in the "source-files" folder, one by one, and will save them to the "result-files" folder.
In the standalone version of **AKVIS Pastel** you can print the image. Press the button to open the **Print** options.

Adjust the parameters appearing in the Settings Panel:

Choose a printer from the list of available devices, set the desired resolution, as well as the number of copies to print.

In the **Orientation** group, set the position of paper: **Portrait** (vertically) or **Landscape** (horizontally).

Click the **Page Setup** button to open a dialog box to choose the size of the paper and its orientation, as well as the print margins.

Press the **Reset Margins** button to return the page margins to the default size.

Change the size of the printed image adjusting the parameters **Scale**, **Width**, **Height** and **Fit to Page**. These parameters have no effect on the image itself, just on the print version. You can change the size of the printed image by entering any value in %, or by entering new values in **Width** and **Height**.

To adjust the size of the image to the paper size, select **Fit to Page**.

Move the image on the page with the mouse or align it using the arrow buttons.

You can activate **Frame** for the image and adjust its width and color.

Choose the **Background Color** by clicking on the color plate.

In the **Page** tab, you can adjust printing of the multiple copies of the image on a single sheet.
Copies per Page. It lets you specify the number of copies of the image on one page.

Horizontally and Vertically. These parameters indicate the number of rows and columns for the copies of the image on the page.

Spacing. The parameter sets the margins between the copies of the image.

In the Poster tab, it's possible to customize printing of the image on multiple pages for the subsequent junction into a large picture.

Pages. If the check-box is enabled, you can specify the maximum number of the pages in which the image will be divided. The image scale will be adjusted to fit this number of the sheets. If the check-box is disabled, the program will automatically select the optimal number of the pages in accordance with the actual size of the image (scale = 100%).

Glue Margins. If the check-box is enabled, you can adjust the width of the padding for bonding sheets. Margins will be added to the right and to the bottom of each part.

Lines of Cut. Activate the check-box to display the cut marks in the margins.

Show Numbers. With the enabled check-box, a sequence number of each part, by a column and a row, will be printed in the margins.

To print the image with the chosen parameters, press the Print button.
To cancel and close the printing options click on Cancel.
Click the **Properties...** button to open a system dialog box that enables you to access the advanced settings and send the document to print.
Swans have always been a symbol of grace, faithfulness and nobleness. This beautiful bird is often considered to be one of the most romantic figures in the world culture. H. C. Andersen wrote the touching story of the little ugly duckling who turns into a beautiful swan. "Swan Lake" composed by P. I. Tchaikovsky is one of the most famous ballets of music history.

In this tutorial you will learn how to create a pastel painting from a photo with **AKVIS Pastel**.

**Step 1.** Open the image in **AKVIS Pastel**.

**Step 2.** The processed fragment will be shown in the quick preview window.
Step 3. Adjust the parameters and start the editing by pressing.

Processing Result: White Background

Step 4. The background color of the previous painting is white. You can specify a different background color by clicking on the color square Paper Color.
The results differ:

Processing Result: Blue Background

(Click on any of the thumbnails to see a larger version of the image)
AKVIS PROGRAMS

AKVIS Sketch Video — Convert Video to Cartoon
(Windows | Mac)

AKVIS Sketch Video is an After Effects and Premiere Pro plugin for converting videos into animated cartoons, both black and white and color. Apply cartoon effects easily with the Sketch Video plugin! More...

AKVIS AirBrush — Airbrushing Techniques on Your Photos
(Windows | Mac)

AKVIS AirBrush automatically transforms a photograph into a work of art which looks like made with a special airbrush tool that sprays paints or inks. The software works as an artistic filter creating stylish colorful airbrush designs from images using chosen settings of photo-to-painting conversion. More...

AKVIS ArtSuite — Frames and Effects for Your Photos
(Windows | Mac)

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains many templates and texture samples that can be used to create a virtually limitless variety of options for generating frames. Decorate a photo to give it an original and festive look! More...
AKVIS ArtWork — Collection of Painting & Drawing Techniques

(Windows | Mac)

**AKVIS ArtWork** is photo to painting software designed to imitate different painting techniques - *Oil Painting, Watercolor, Gouache, Comics, Pen & Ink, Linocut, Pastel*. ArtWork helps you to create a piece of art out of any picture! [More...](#)

AKVIS Chameleon — Photo Collage Creation

(Windows | Mac)

**AKVIS Chameleon** is a fun to use tool for photo collage creation. It makes the process easy and entertaining.
The tool is very easy to handle as it does not require precise selection of objects. Using the software you can quickly create your own photo collages. More...

AKVIS Charcoal — Charcoal & Chalk Drawings
(Windows | Mac)

AKVIS Charcoal is a creative tool for conversion of photos into charcoal and chalk drawings. Using the program you can make professional-looking expressive black and white images. Playing with colors and options you can achieve outstanding artistic effects, such as sanguine and others. More...

AKVIS Coloriage — Add Color to Black and White Photos
(Windows | Mac)

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color photos. Just indicate the desired colors by the stroke of the brush; the program does the rest of the work: recognizes the object’s border and tailors the new color to the grayscale tones of the initial picture. More...
AKVIS Decorator — Resurface and Recolor

(Windows | Mac)

**AKVIS Decorator** lets you change the surface of an object in a realistic manner. The program puts on a texture keeping the volume of an object, following its folds and creases. The new pattern looks absolutely natural and makes you see things differently. Recoloring is also made easy. More...

AKVIS Draw — Hand-made Pencil Drawing Effect

(Windows | Mac)

**AKVIS Draw** converts your photos into hand made pencil drawings. The software creates realistic looking line art illustrations, produces both B&W and color drawings. Add a hand-drawn look to your pictures! More...

AKVIS Enhancer — Bring Detail To Your Pictures

(Windows | Mac)

**AKVIS Enhancer** is image enhancement software that detects detail in underexposed, overexposed and mid tone
areas of a photo with uneven exposure. Enhancer improves every part of the image! The software works in three modes: Improve Detail, Prepress, and Tone Correction. The program offers a fast method to fix a dark photo, add contrast and brightness to a picture, it lets you improve color and adjust tones. More...

AKVIS Frames — Decorate Your Photos with Frames

(Windows | Mac)

AKVIS Frames is free software designed for working with the AKVIS frame packs. Using the program it’s easy to decorate your photos with exclusive picture frames! More...

AKVIS HDRFactory — High Dynamic Range Images: Brighter than Reality!

(Windows | Mac)

AKVIS HDRFactory lets you create a High Dynamic Range image from a series of shots or from one single photo. The program can also be used for photo correction. The program brings life and color to your photos! More...
AKVIS LightShop — Light and Star Effects
(Windows | Mac)

**AKVIS LightShop** lets you create an infinite number of astounding light effects! The program offers advanced lighting techniques for adding stars and glow effects to images. A light effect draws attention and brighten up any photo. Add a little magic to your pictures! More...

AKVIS Magnifier — Change Image Size without Quality Loss
(Windows | Mac)

**AKVIS Magnifier** helps to resize images without loss in quality. Whether creating poster-size images, adding resolution for printing an enlargement, or reducing image size, Magnifier will make your prints look sharper and better defined. More...
**AKVIS MakeUp — Retouch Your Portrait Photos!**

(Windows | Mac)

**AKVIS MakeUp** improves your portraits giving them a professional look. The software retouches facial imperfections making your skin radiant, beautiful, pure and even. The program adds glamour to your pictures and creates a high key effect. Look your best in every photo with AKVIS MakeUp! More...

**AKVIS NatureArt — Bring Nature to Your Photos**

(Windows | Mac)

**AKVIS NatureArt** is an excellent tool for imitating the magnificence of natural phenomena on your photos. Add dramatic nature effects to your photo, change the weather on it! With NatureArt you can become a wizard! More...
AKVIS Neon — Glowing Drawings from Photos

(Windows | Mac)

AKVIS Neon lets you create amazing glowing lines effects. The software transforms a photo into a neon image that looks like drawn with luminescent ink. More...

AKVIS Noise Buster — Digital Noise Reduction

(Windows | Mac)

AKVIS Noise Buster is software for noise suppression on digital and scanned images. Digital noise can be seen as artifacts and random red and blue pixels that compromise the smoothness of a photo. The program is efficient against both color and luminance noise. More...
AKVIS OilPaint — Oil Painting Effect

(Windows | Mac)

AKVIS OilPaint turns your photos into oil paintings. The mysterious production of a painting happens right before your eyes. The unique algorithm authentically reproduces the technique of the real brush. With this cutting-edge software you can become a painter! More...

AKVIS Pastel — Turn Photos into Pastel Paintings

(Windows | Mac)

AKVIS Pastel turns your photos into pastel paintings. The program converts your photo into a lifelike digital art imitating one of the most popular artistic techniques. AKVIS Pastel is a powerful tool to unleash your creativity! More...
AKVIS Points — Apply Pointillism Effect to Your Photos

(Windows | Mac)

**AKVIS Points** lets you transform your photos into paintings using one of the most exciting artistic techniques - pointillism. With the software you can easily create gorgeous works of art in a pointillist manner. Discover the world of bright colors! More...

AKVIS Refocus — Focus Improvement & Blur Effects

(Windows | Mac)

**AKVIS Refocus** improves sharpness of out of focus images. The program can process the entire photo or bring into focus only the selected part to make the subject stand out against the background. It's also possible to add bokeh and lens blur effects to your photos.

The software works in five modes: **Refocus**, **Tilt-Shift**, **Iris Blur**, **Motion Blur**, and **Radial Blur**. More...

AKVIS Retoucher — Image Restoration Software

(Windows | Mac)

**AKVIS Retoucher** is an efficient program for photo restoration and photo retouching. The software removes dust, scratches, stains, and other defects that appear on damaged photos. It intelligently reconstructs the missing parts of the photo using the information of the surrounding areas. More...
AKVIS Sketch — Convert a Photo to a Pencil Sketch

(Winodws | Mac)

AKVIS Sketch converts digital photos to amazing pencil sketches and watercolor drawings. Now you do not need to handle a pencil to feel like an artist. All you need to create your original work of art is good taste and AKVIS Sketch. More...

AKVIS SmartMask — Save Time on Complex Selections!

(Winodws | Mac)

AKVIS SmartMask is an efficient selection tool that saves time and is fun to use. Selection has never been so simple! The software considerably increases your productivity. You will be freed from boring work and will have
more room for creativity and realization of your ideas. More...

AKVIS Watercolor — Aquarelle Art from Photos
(Windows | Mac)

AKVIS Watercolor easily makes a photo look like a brilliant and vibrant watercolor painting. The software turns ordinary images into amazingly realistic aquarelle pieces of art. More...